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WARRANTY

Tektronix warrants that the products that it manufactures and sells will be free from defects
in materials and workmanship for a period of one (1) year from the date of purchase from
an authorized Tektronix distributor. If any such product proves defective during this
warranty period, Tektronix, at its option, either will repair the defective product without
charge for parts and labor, or will provide a replacement in exchange for the defective
product. Batteries are excluded from this warranty.

In order to obtain service under this warranty, Customer must notify Tektronix of the
defect before the expiration of the warranty period and make suitable arrangements for the
performance of service. Customer shall be responsible for packaging and shipping the
defective product to the service center designated by Tektronix, shipping charges prepaid,
and with a copy of customer proof of purchase. Tektronix shall pay for the return of the
product to Customer if the shipment is to a location within the country in which the
Tektronix service center is located. Customer shall be responsible for paying all shipping
charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or
improper or inadequate maintenance and care. Tektronix shall not be obligated to furnish
service under this warranty a) to repair damage resulting from attempts by personnel other
than Tektronix representatives to install, repair or service the product; b) to repair damage
resulting from improper use or connection to incompatible equipment; c) to repair any
damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a
product that has been modified or integrated with other products when the effect of such
modification or integration increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE
LISTED PRODUCTS IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. TEKTRONIX’ RESPONSIBILITY TO REPAIR OR REPLACE
DEFECTIVE PRODUCTS IS THE SOLE AND EXCLUSIVE REMEDY
PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.
TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS
ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent
damage to this product or any products connected to it. To avoid
potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the
system. Read the General Safety Summary in other system manuals
for warnings and cautions related to operating the system.

WARNING. To avoid injury, do not connect this product to any source
which may be subject to the effects of lightning. See page 1–12 for
complete information.

To Avoid Fire or Personal Injury
Use Proper Power Cord. Use only the power cord specified for this
product and certified for the country of use.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all
ratings and markings on the product. Consult the product manual for
further ratings information before making connections to the product.

Replace Batteries Properly. Replace batteries only with the proper type
and rating specified.

Recharge Batteries Properly. Recharge batteries for the recommended
charge cycle only.

Use Proper AC Adapter. Use only the AC adapter specified for this
product.

Do Not Operate Without Covers. Do not operate this product with
covers or panels removed.

Avoid Exposed Circuitry. Do not touch exposed connections and
components when power is present.
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Wear Eye Protection. Wear eye protection if exposure to high-intensity
rays or laser radiation exists.

Do Not Operate With Suspected Failures. If you suspect there is damage
to this product, have it inspected by qualified service personnel.

Do Not Operate in an Explosive Atmosphere.

Safety Terms and Symbols
Terms in This Manual. These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that
could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that
could result in damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you
read the marking.

WARNING indicates an injury hazard not immediately accessible as
you read the marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. These symbols may appear on the product:

CAUTION
Refer to Manual
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Battery Recycling
This product contains a Lithium-Ion battery, which must be recycled
or disposed of properly. For the location of a local battery recycler in
the U.S. or Canada, please contact:

RBRC (800) BATTERY
Rechargeable Battery Recycling Corp. (800) 227-7379
P.O. Box 141870 www.rbrc.com
Gainesville, Florida 32614
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Preface

This manual contains set up and operating instructions for the
NetTek YBT1 T1 Circuit Tester.

About This Manual
This manual is divided into four sections: Getting Started, Operating
Basics, Reference, and Appendices.

The Getting Started section explains how to install and start up your
T1 Circuit Tester.

The Operating Basics section explains how to operate the tester.

The Reference section explains how to perform tests.

The Appendices contain reference information you might need
occasionally, such as specifications or diagnostic procedures.

Online Help Information
The NetTek YBT1 T1 Circuit Tester contains online help to enable
you to quickly get explanations on how to operate the tester. The
online help is the first place you should look for information.

The NetTek YBT1 is based on the Y350 NetTek Analyzer Platform.
You will find important information about configuring and operating
the NetTek Analyzer Platform in the Y350 NetTek Analyzer Platform
User Manual, Tektronix part number 071-0805-XX. Additionally, the
analyzer platform supplies its own built-in online help.
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Conventions
The statement Start > Help is requesting that you open the Start
menu and select Help. To do this, tap the Start button in the toolbar
at the bottom of the desktop window; then tap Help in the resulting
menu.

Software Version
This manual supports T1 Circuit Testers running software
Version 1.1 and above.

To verify your software version, do the following:

1. In the toolbar at the top of the startup screen, select Tools.

2. Select Software Info.
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Contacting Tektronix 

Phone 1-800-833-9200*

Address Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

Web site www.tektronix.com

Sales
support

1-800-833-9200, select option 1*

Service
support

1-800-833-9200, select option 2*

Technical
support

Email: techsupport@tektronix.com

1-800-833-9200, select option 3*

6:00 a.m. – 5:00 p.m. Pacific time

* This phone number is toll free in North America. After office
hours, please leave a voice mail message. Outside North
America, contact a Tektronix sales office or distributor; see the
Tektronix web site for a list of offices.
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Getting Started

This section contains the information you need to set up the NetTek
YBT1 T1 Circuit Tester:

� Installing software

� Assembling the product

� Installing the PC card

� Starting the software

� Performing a functional check

Product Description
The NetTek YBT1 T1 Circuit Tester is part of the NetTek BTS Field
Tool family: a high-performance, portable, field-ready tester,
optimized for rapid trouble shooting and base station performance
verification.

The NetTek YBT1 compliments the functionality of the YBT250
NetTek Field Transmitter and Interference Tester module, which
operates on the Y350 NetTek Analyzer Platform.

Use the NetTek YBT1 to ensure the proper operation of T1 data lines
by verifying synchronization, line framing, bit errors, and other
important characteristics. The NetTek YBT1 circuit tester can
perform measurements on both in-service and out-of-service
networks, in order to support communications industry customer
requirements.
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Figure 1–1: The NetTek YBT1 T1 Circuit Tester

Product Features

The NetTek YBT1 T1 Circuit Tester features include the following;

� Standards and technology compliance: T1.402, T1.403, G.703

� Line coding compatibility: AMI, B8ZS

� Frame format compatibility: D4 Superframe and ESF

� Connection configurations: single-port monitor, bridge,
terminate, receive-to-transmit loopback

� Transmission timing: internal or recovered

� DS0 Drop: visual display of ones density

� Error insertion: single bit error, single bipolar violation (BPV),
single frame error, single cyclic redundancy check (CRC) error
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� Error detection: bit errors, bit-error rate, frame errors, bipolar
violations, cyclic redundancy check errors, errored seconds

� Alarm reporting: carrier loss, frame loss, pattern synchronization
loss, AIS/Blue, RAI/Yellow, excessive zeros, ones density failure

� Status indicators: T1 pulses, frame synchronization, BERT (Bit
Error Rate Test) pattern synchronization, B8ZS line coding

� Counters: BERT pattern errors, bipolar violations, frame errors,
CRC errors

� Bit Error Rate Test patterns: QRSS, All Zeros, All Ones, 1-in-7,
2-in-8, 3-in-24, T1-1 (Min/Max), T1-2 (Trip Test), T1-3
(54-Octet), T1-4 (120 Octet), T1-5 (53 Octet), T1-6 (55 Octet)

� User-definable transmit levels

� Line impedance: monitoring (100 ��, terminating (100 �),
bridging (1 k�)

� Automated testing: frame mode detection, line coding detection,
CRC-6 error sensing, timed test, BER-pattern sequence

Components and Accessories

Table 1–1 contains general information on YBT1 T1 Circuit Tester
components and accessories.

For a complete list of standard and optional accessories, see
Appendix B, beginning on page B–1.
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Table 1–1: Components and accessories 

YBT1 PC Card. Acts as the product platform and provides
a T1 digital interface to the Y350 NetTek Analyzer Platform.
See page B–1 for replacement information. 

T1 Line Interface. Adapts the PC card interface to RJ48
test cables. See page B–1 for replacement information.

RJ48-to-Bantam Y Cable. Provides a RJ48-compatible
connection between the T1 Line Interface and a DSX patch
panel. See page B–1 for replacement information. 

RJ48-to-RJ48 Straight-Wired Cable. Provides a
RJ48-compatible connection between the T1 Line Interface
and base station equipment. See the list of optional
accessories on page B–2 for ordering information. 

RJ48-to-RJ48 Cross-Wired Cable. Provides a RJ48-com-
patible connection between the T1 Line Interface and the
base station NIU (Network Interface Unit). See the list of
optional accessories on page B–2 for ordering information. 

RJ48-to-Alligator Clip Cable. Provides a connection
between the T1 Line Interface and the internal wiring of
base station equipment. See the list of optional accessories
on page B–2 for ordering information. 

RJ48 Loopback Plug. Connects the NetTek YBT1 receive
input to the NetTek YBT1 transmit output when plugged into
the T1 Line Interface. Required to run the diagnostic self
tests. See page B–1 for replacement information. 

Installation Software CD-ROM. Installs NetTek YBT1
software on the Y350 NetTek Analyzer Platforms from a
desktop computer. See page B–1 for replacement
information. 

User Manual. Provides set up and basic operating
information. (The CD-ROM is packaged inside the user
manual.) See page B–1 for replacement information. 
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Installing NetTek YBT1 Software 

If you purchased your Y350 NetTek Analyzer Platform and NetTek
YBT1 directly from Tektronix, the T1 Circuit Tester software is
already installed and ready to operate.

NetTek YBT1 Field Tool Software Purchased Separately

If you purchased NetTek BTS Field Tools previously and are adding
the NetTek YBT1 T1 Circuit Tester, follow the procedure on
page D–1 to install the NetTek YBT1 software on the Y350 NetTek
Analyzer Platform.

Software Upgrades 

To upgrade or reinstall NetTek YBT1 software on the Y350 NetTek
Analyzer Platform, follow the procedure on page D–1.

Assembling the PC Card and Line Interface 
1. Connect the PC card to the T1 Line Interface. See Figure 1–2.

2. Connect the RJ48 cables suited to your test to the line interface.

RJ48 test cable
T1 Line Interface

YBT1 PC card

Figure 1–2: Assembling the NetTek YBT1
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Installing the PC Card
Use the following procedure to install the NetTek YBT1 PC card in
the Y350 NetTek Analyzer Platform.

CAUTION. To meet the electromagnetic emissions standards specified
for this product, install the NetTek YBT1 PC card in the rear slot of
the NetTek Analyzer Platform as shown in Figure 1–3. In addition,
do not install any other PC card while using the NetTek YBT1 card.

1. Place the NetTek Analyzer Platform on a flat surface with the
touch-screen display facing towards you.

2. Open the PC card access door on the right side of the analyzer.
See Figure 1–3.

3. Slide the PC card into the rear PCMCIA slot as shown in
Figure 1–3. Make sure the Tektronix side of the label faces
toward the display.

4. Press in firmly to seat the PC card connector.

5. To release the card later, press the button at the top of the card
slot.
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Access door

YBT1 PC card

Install the NetTek YBT1 PC
card in this slot.

Figure 1–3: Installing the PC card
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Securing the Cables 
To prevent damage to the PC card and line interface connections by
overextending the cables, you may want to secure the line interface
to the side of the Y350 NetTek Analyzer Platform with the included
Velcro strips. See Figure 1–4.

Attach Velcro here.

Secure the line interface to the side of the
Y350 analyzer with the enclosed Velcro strips.

Figure 1–4: Attaching the line interface to the Y350 NetTek Analyzer
Platform
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Powering on the Tester 
Press the large blue oval button in the lower-left corner of the Y350
NetTek Analyzer Platform. The power status indicator illuminates
immediately. Allow approximately one minute for the analyzer
platform to complete the power-on sequence.

Starting the NetTek YBT1 Software
You have the following options to start up the NetTek YBT1
measurement software:

� Double-tap the YBT1 application icon on the NetTek Analyzer
Platform desktop if present. The shortcut icon must be previously
user created or set up at the factory.

� Select Start > Programs > NetTek > YBT1 in the taskbar.

� Depending on the configuration of your NetTek Analyzer
Platform, the T1 Circuit Tester software may start up automati-
cally at power on.
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Performing a Functional Check 
Following installation and start up of the NetTek YBT1 software,
perform the following procedure to verify that the T1 Circuit Tester
is functioning properly.

1. Insert the RJ48 Loopback Plug into the T1 Line Interface as
shown in Figure 1–5.

2. Perform the diagnostic tests on page C–1.

Loopback plug

Figure 1–5: Inserting the Loopback Plug into the T1 Line Interface

Powering Off the Tester 
The NetTek YBT1 has separate, interrelated, standby and power off
functions.

Suspend Mode

Use Suspend mode to place the NetTek YBT1 in a suspended
(standby or sleep) state. This is the typical power down mode that
allows the NetTek YBT1 software to remain in volatile memory. If
the NetTek YBT1 remains in Suspend mode for an extended time
(approximately two hours), it will automatically enter Shutdown
mode.



Getting Started

NetTek YBT1 T1 Circuit Tester User Manual 1–11

To suspend NetTek YBT1 operations, choose one of the following
methods:

� Press the front-panel power switch.

� Select Start > Shutdown. In the Shut Down dialog box, select
Suspend.

To cancel Suspend mode and wake up the NetTek YBT1, press the
front-panel power switch. The NetTek YBT1 will return to the
operating state that existed before suspend mode was evoked.

Shutdown

To completely power down the NetTek YBT1, do the following:

1. Select Start > Shutdown.

2. In the Shut Down dialog box, select Shutdown.

The next time you press the front-panel power switch, the NetTek
YBT1 will cycle through the complete power up process taking
approximately two to three minutes to power up.

Restart (Software Reset)

To reset the NetTek YBT1 software:

1. Select Start > Shutdown.

2. In the Shut Down dialog box, select Restart.

The display blanks for approximately five seconds. The NetTek
YBT1 software will reload and start up.

Understanding the Power Switch
Depending on the current state of the NetTek YBT1, pressing the
front-panel power switch performs one of the following functions:

� If the NetTek YBT1 is shut down: powers on the instrument.

� If the NetTek YBT1 is operating: initiates Suspend mode.

� If the NetTek YBT1 is in Suspend mode: cancels Suspend mode
and activates the NetTek YBT1.
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� If the NetTek YBT1 is in PowerSaver mode (touch-screen display
off): activates the display.

Preventing Personal Injury from the Effects of Lightning 

WARNING. To prevent personal injury from the effects of lightning,
exercise the following precautions when using this product.

Before connecting this product to any source

� Be sure there is no lightning in your vicinity.

� Check your local weather forecast for the possibility of
thunderstorms or lightning.

� If weather conditions could allow thunderstorms or lightning to
develop, be sure to visually check the sky and weather conditions
in your area frequently.

� If you hear thunder or see lightning, do not connect this product
to any source that may be exposed to the effects of lightning.

� Use your own good judgement and common sense. You must
protect yourself from the effects of lightning.

� You must assume that hazardous voltages will be present on
exposed surfaces of this product if it is connected to a source
exposed to lightning. The insulation of this product will not
protect you from these hazardous voltages.

Do not connect this product to any source that might be subject to the
effects of lightning

If thunderstorms or lightning are in your vicinity:

� When weather conditions that could lead to lightning activity
exist in your area, you could be at risk of a lightning strike
before the cloud is close enough for you to hear thunder or see
lightning.
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� When lightning strikes a structure or facility, current travels
through the rebar, concrete, pipes, cables, vent stacks, and
electrical system.

� Lightning can induce electric and magnetic fields into structures
and portions of wiring. The length of a conductor affected by the
magnetic field of a lightning strike may exceed two miles.

Be alert and aware of the effects of lightning

� When lightning strikes a conductor, which in turn introduces
current into an area some distance from the ground strike point,
equipment can be damaged and personnel injured if they
become an indirect path in the completion of the ground circuit.

� Conductors such as the braided shields of cables or unshielded
wire, will have significant transient currents flowing in them in
regions exposed to the electric field effect of lightning.

� Induced voltages may cause breakdown of insulation in wiring at
connectors and in electrical components, or breakdown of air.
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Operating Basics 

This section contains the basic information you need to operate the
NetTek YBT1 T1 Circuit Tester:

� Identifying the front-panel controls

� Navigating the desktop

� Entering text with the soft keyboard

� Getting help

� Understanding the test windows

Overview
The NetTek YBT1 is a member of the Tektronix NetTek Series of
modular instruments based on the NetTek Analyzer Platform. A
NetTek Series instrument consists of a hardware module,
application software, and the Y350 NetTek Analyzer Platform.
NetTek Series instruments, such as the NetTek YBT1, can be
purchased with or without a NetTek Analyzer Platform.

The NetTek Analyzer Platform is a specialized Windows CE-based
computer. The platform provides the power source and display for
NetTek Series instruments. A hardware module for each NetTek
Series instrument provides the circuitry and the associated software
provides the instrument interface and analysis capability.

The NetTek YBT1 is equipped with a touch-screen display and
stylus. Use the stylus as you would the mouse on your desktop
computer. You can select an object by tapping it, move it by
dragging it, or activating it by double-tapping it.

CAUTION. Only use soft objects, such as plastic or your finger, to tap
the touch-screen display. Do not use metal or other abrasive
materials as they will damage the display surface.
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Identifying Front-Panel Controls and Indicators
The front-panel controls power the NetTek Analyzer Platform on and
off, reset the analyzer, and indicate operating status.

1 2 3 4

Figure 2–1: NetTek Analyzer Platform front-panel controls and
indicators

1. Power/Suspend Switch. Push on; push off. See pages 1–9 and
1–10 for additional information.

2. Reset Switch. Push to perform a hardware reset if the tester
locks-up. Programs and other data loaded into volatile memory
since startup will be lost.
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3. Status Indicator. Green indicates power on. Amber indicates
display off PowerSaver mode.

4. Batteries Indicator. Green indicates the instrument is connected
to an external power source and charging an installed battery.
Red indicates a low battery.

Navigating the Desktop
The NetTek Analyzer Platform desktop is your primary workspace.
Use the desktop to configure hardware and software, adjust settings,
establish communications, and access application software.

Taskbar

Desktop

Icon

Figure 2–2: The NetTek Analyzer Platform desktop
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Icons

Double-tap desktop icons to open folders or to start programs.

Taskbar

The Taskbar contains the Start menu, buttons to identify the
programs you are running, a status area, and a desktop icon.

Desktop button

Program button Status area

Start menu

Start Menu. Use the Start menu to load and run instrument modules
and other programs, access settings, open documents, and obtain
help. Select (tap) Start to open the menu; then select the entry you
want.

For detailed information on Start menu selections, see the Y350
NetTek Analyzer Platform User Manual.

Select Start to open

Desktop Button. Tap the desktop icon to minimize all running
programs and display the desktop.
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Program Buttons. To hide a program that is running, select its taskbar
button. To restore the program, select the button again.

Status Area. Icons and buttons appearing in this area indicate status,
activate features, or open settings windows. Double-tap the icons for
further information.

Table 2–1 explains the function of some common status icons. For a
complete list and explanation of all status area icons, refer to the
NetTek Analyzer Platform online help. Select Start > Help. In the
Help window select Windows CE Basics; then select Understand-
ing Taskbar Icons.

Table 2–1: Status area icons 

Tap icon To Details

Double-tap to open the Power
Management utility.

The analyzer is operating
on external AC power.

Double-tap to open the Power
Management utility.

The analyzer is charging
batteries.

Double-tap to open the Power
Management utility.

The analyzer is operating
on battery power. Also
indicates charge level.

Double-tap to open the Backlight
utility.

Adjust the backlight bright-
ness.

Single-tap to open the Input
Panel soft keyboard.

Single-tap to close the
keyboard.

Double-tap to open the Date/Time
utility.

Set the date and time.
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Entering Text 
Use the NetTek Analyzer Platform soft keyboard to type characters
into text boxes or address fields without using an external keyboard.

Figure 2–3: Soft keyboard

1. Tap the  icon in the toolbar status area.

2. Tap the Input Panel keys to enter text.

3. Tap (RETURN) to wrap text or execute a command.

4. Tap the keyboard icon to close the keyboard.

To set soft keyboard properties, select Start > Settings > Control
Panel. Open the Input Panel icon, and then select Options.

Special Characters

The soft keyboard includes characters not visible on the startup
keyboard.

CAP Key. Tap the CAP (lock) key to create all capital letters and
common characters.

Shift Key. Tap the Shift key to create a single capital letter or
common character.

AU Key. Tap the  key to create special characters.
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Getting Help 
To open the Help Contents menu on the Y350 NetTek Analyzer
Platform, select Start > Help in the Taskbar.

To open the Help window and obtain information on T1 Circuit
Tester topics, select Help from the Start menu; then select NetTek
YBT1 T1 Circuit Tester.

Use the following methods to obtain help while running the T1
Circuit Tester:

� Tap the  icon in the upper-right corner of the touch screen to

display the top level of NetTek YBT1 help.

� Tap underlined text to display information on this topic.

� Tap the Help button in a dialog box, if present, to display
task-specific information.

The Help Window

Table 2–2 explains how to use the Help window buttons.

Table 2–2: Help window buttons 

Tap this button To

All Topics Display the NetTek Analyzer Platform main table of
contents.

Back Return to the previous help screen.

Contents Display the current program or local table of contents.

Display full-screen help text.

Display the help text in its own window. Tap and drag
the Help window title bar to move the window.

Close the Help window. To reopen the window, tap
the Help icon in the taskbar.

Close the Help window and quit help.
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Table 2–2: Help window buttons (Cont.)

Tap this button To

Scroll the text towards the bottom of the screen.

Scroll the text towards the top of the screen.

Using the Main Controls 
Figure 2–4 shows the common controls used in the test windows.

Figure 2–4: NetTek YBT1 main controls
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Toolbar Buttons 

Table 2–3 shows the toolbar buttons and explains their function.

Table 2–3: Toolbar icons 

Tap this icon To Details

Open the File menu Save or export results and
screens; exit the software.

Open the Setup menu Edit settings; access or
save user data; return to
factory default settings.

Open the Tools menu Configure option settings;
open the keyboard; cali-
brate the touch screen;
upgrade a module; obtain
hardware and software
version information.

Save results Save current results to
default file location.1

Open the instrument
Settings window

Configure instrument set-
tings. See page 3–8.

Pause a test Allows viewing or capture
of results screens.2

Resume a test

Open the help window Obtain NetTek YBT1 help.

1 BuiltInDisk\YBT1\Results.
2 Data collection continues while screen is paused.
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Configuration Buttons 

Select a button for the type of circuit connection you want to make.
For detailed information on connecting the NetTek YBT1 to a signal,
see page 3–1.

Monitor. Selecting Monitor provides a nominal 100 � input

impedance and compensates for the 20 dB resistive loss of a DSX
monitor port. This setting is useful for in-service monitoring of T1
lines at DSX monitor ports that are resistor-isolated. The YBT1
transmitter is disabled in Monitor mode.

Bridge. Selecting Bridge provides greater than 1 �k input
impedance for bridging lines that are already terminated. This setting
compensates for cable loss of up to 10 dB. The YBT1 transmitter is
disabled in Bridge mode.

Terminate. Selecting Terminate provides a nominal 100 �

input impedance. This setting compensates for up to 10 dB of cable
loss for T1 lines. This setting is useful for out-of-service termination
of a T1 circuit during testing.

Terminate mode enables the YBT1 transmitter for error insertion
testing.

Loopback. Selecting Loopback provides a nominal 100 �

input impedance and compensates for up to 10 dB of cable loss for
T1 lines. Loopback performs measurements on the received data
while looping the payload data from the receiver to the transmitter.
Loopback is useful when testing from the far end of a T1 line.

Drop DS0 Button 

Opens the DS0 Activity Graph. This view displays the data activity
for each of the T1 time slots. Activity is indicated as percentage
ones-density in the each time slot, represented as a unique color
ranging from all zeros through all ones in 10% increments.

Each row of the display represents a user-defined period of time.
Over multiple time periods, the display builds up row-by-row with
the oldest row dropping from the top of the view as the newest row is
added to the bottom.
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Show Last Results Button 

Returns the test results history that has accumulated since the last
time you selected the Restart button. You can use most of the tester
controls to walk through the logged data.

Timed Test Button 

Opens the Timed Test window. Use this window to define the length
of time to run the tester for a controlled test.

Automated Test Button 

Opens the Automated Test window. Use this window to select and
run a preset test pattern sequence.

Restart Button  

Select this button to reset all of the current measurement status and
history, including error and alarm counts. If any instrument setting is
configured for “Same as Rx Signal”, a Restart will initiate the
receiver detection algorithm for the selected setting(s).

NOTE. If you accidentally selected Restart and want to return the
previous test results, select Saved Last Results.

Summary Button  

Select this button to open the Summary window. See page 2–14 for
detailed information.

Alarms Button  

Select this button to open the Alarms window. See page 2–15 for
detailed information.

Errors Button  

Select this button to open the Errors window. See page 2–17 for
detailed information.
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Alarm/Error Count Button  

Select this button to open the Alarm/Error Count window. See
page 2–19 for detailed information.

T1 Pulse Indicator  

Identifies valid T1 pulses at the Receive input.

� Green indicates T1 pulses detected.

� White indicates the NetTek YBT1 is searching for T1 pulses.

During the search the T1 pulse indicator displays Receiving. If the
NetTek YBT1 detects T1 pulses at a level too low to make accurate
measurements, it displays Weak Signal and continues searching.

Frame Sync Indicator  

The NetTek YBT1 identifies the framing at the Receive input and
compares it with the framing selected in the Settings Instrument tab
(Setup > Edit).

� Green indicates that the received framing type matches the
instrument settings.

� Red with an X indicates that the received framing type does not
match the instrument settings.

� White indicates that the NetTek YBT1 is searching for the
framing type.

The Frame Sync Indicator always displays the type of framing
detected: D4 or ESF, even if it does not match the instrument
settings. During the search the indicator displays Receiving.

Pattern Sync Indicator  

The NetTek YBT1 identifies the data pattern at the Receive input
and compares it with the BER pattern selected in the Settings
Instrument tab (Setup > Edit).

� Green indicates that the received BER pattern matches the
instrument settings.
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� Red with an X indicates that the received BER pattern does not
match the instrument settings.

� White indicates that the NetTek YBT1 is searching for the BER
pattern type.

The Pattern Sync Indicator always displays the type of pattern
detected: QRSS, ALL Ones, All Zeros, 1 in 8, etc, even if it does not
match the instrument settings. During the search, or if the pattern
cannot be identified, the indicator displays Receiving.

Line Coding Indicator  

The NetTek YBT1 identifies the line coding at the Receive input and
compares it with the line coding selected in the Settings Instrument
tab (Setup > Edit).

� Green indicates that the received line coding matches the
instrument settings.

� Red with an X indicates that the received line coding does not
match the instrument settings.

� White indicates that the NetTek YBT1 is searching for the line
coding type.

The Line Coding Indicator always displays the type of coding
detected: AMI or B8ZS, even if it does not match the instrument
settings. During the search the indicator displays Receiving.

Instrument Settings
For information on how to modify the NetTek YBT1 instrument
settings, such as line coding, framing, transmitter clock, BER test
patterns, and transmitter output level, or perform specialized testing
on T1 circuits, see page 3–8.
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Understanding the Summary Window
This is the default window you see at startup. The Summary window
reports the accumulated results since the last time you began a test or
selected the Restart button. View this window to obtain general
information before navigating to other windows for detailed results.

To open this window, select the Summary button on the right side of
the display.

Figure 2–5: NetTek YBT1 Summary window

T1 Circuit Test Summary 

This field summarizes the current test results.

OK. Indicates that no alarms or errors were detected during the test
period or since the last Restart.
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Alarm Detected. Indicates that an alarm was detected during the test
period. Tap the alarm indicator to open the Alarm window for
additional details (This is the same as selecting the Alarms button).

Error Detected. Indicates that an error was detected during the test
period. Tap the Errors indicator to open the Errors window for
additional details (This is the same as selecting the Errors button).

Understanding the Alarms Window
The Alarms window reports individual test results collected during
the test period. View this window to obtain alarms history from the
Alarms rolling display. To open to the window, select the Alarms
button on the right side of the display.

Selected alarm box Event indicatorHistory button

Figure 2–6: NetTek YBT1 Alarms window
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History Button 

 Tap an Alarm Type history button to open the Test History window.
View this window for detailed information on the selected alarm,
including the total alarm count.

Alarms Display 

The Alarms rolling display scrolls from right to left to capture alarm
events in time.

Current Indicator

Red indicates that this Alarm Type is currently being detected.

Display Timespan 

The timespan of the rolling displays is fixed to one minute and
cannot be adjusted. Select a History button to view details of the last
100 alarms.

Selected Alarm Scroll Box

If you tap an event indicator in the Alarms rolling display, the
indicator will turn yellow and information on the time, date, and
number or alarms associated with the event will appear in the
Selected Alarm Scroll Box.

Tap the left arrow to select the previous alarm in the same row. Tap
the right arrow to select the next alarm in the same row.
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Understanding the Errors Window
The Errors window reports individual test results collected during
the test period. View this window to obtain errors history from the
Errors rolling display. To open to the window, select the Errors
button on the right side of the display.

Selected error box Event indicatorHistory button

Figure 2–7: NetTek YBT1 Errors window

History Button 

Tap an Error Type history button to open the Test History window.
View this window for detailed information on the selected error,
including the total error count.
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Errors Display 

The Errors rolling display scrolls from right to left to capture error
events in time.

Current Indicator

Red indicates that this Error Type is currently being detected.

Display Timespan 

The timespan of the rolling displays is fixed to one minute and
cannot be adjusted. Select a History button to view details of the last
100 errors.

Selected Error Scroll Box

If you tap an event indicator in the Errors rolling display, the
indicator will turn yellow and information on the time, date, and
number or errors associated with the event will appear in the
Selected Error Scroll Box.

Tap the left arrow to select the previous error in the same row. Tap
the right arrow to select the next error in the same row.

BER Count

The BER = indicator (bit error rate indicator) displays the cumula-
tive bit error rate since the last time you began a test or selected the
Restart button. The reported BER is calculated on the total number
of bits received while in a pattern synchronization condition.

Error Insertion List Box 

To insert a single error into the NetTek YBT1 output data stream:

1. Configure the NetTek YBT1 for a Terminate connection. See
page 3–4 for instructions.

2. Select an error type from the Errors Insertion drop-down list box.

3. Tap Insert.

The NetTek YBT1 transmits the single error immediately. You must
loop the far end connection to monitor errors at the Rx (Receive)
input of the NetTek YBT1.
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Understanding the Alarm/Error Count Window
The Alarm/Error Count window lists test results since the last time
you began a test or selected the Restart button.

View this window for detailed information on the last 100 alarms
and errors, including the alarm/error type, number of occurrences
(count), and the time of each occurrence.

You can sort the information in this window by alarms/errors type,
count (in descending order), and time of occurrence by tapping the
appropriate column header.

To open this window, select the Alarm/Error Count button on the
right side of the display.

Figure 2–8: NetTek YBT1 Alarm/Error Count window
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Connecting to a Signal 

There are several ways to connect the NetTek YBT1 to a T1 circuit
within the base station environment. Each type of connection allows
you to test a different aspect of functionality.

Base station
equipment

Channel
Service

Unit

Network
Interface

Unit

Tx Tx

Rx

Demarcation

Telco
Wireless
operator

DSX1 panel

Rx

DSX2 panel

Figure 3–1: Typical base station showing T1 network interfaces 

Making a Monitor Connection
This is the most common type of connection to a DSX service panel.
In this configuration, you can use the YBT1 to monitor either the
network side or the customer side of the data stream without
removing the line from service. This configuration does not transmit
data, therefore it does not block communications on either side.

Use this configuration to detect errors on the line, such as Bipolar
Violations (BPV) and CRC (Cyclic Redundancy Check) errors, or to
perform bit error-rate testing if a known test pattern is being
received.
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As a typical example, to monitor an outgoing signal at a DSX
service panel, configure the NetTek YBT1 as follows:

1. Connect the RJ48-to-Bantam Y Cable to the T1 Line Interface.
See page 1–5.

2. Select the Monitor option button in the NetTek YBT1 Configu-
ration field.

3. Connect the Bantam “Receive” plug to the monitor jack on the
DSX1 service panel as shown in Figure 3–2.

4. Select the Summary button on NetTek YBT1.

5. Press Restart to clear any error/alarm counts and restart the test.

MON

DSX1

OUT

IN IN

OUT

MON

To base station

From CSU

Figure 3–2: Typical connection for single-port monitoring



Connecting to a Signal

NetTek YBT1 T1 Circuit Tester User Manual 3–3

Making a Bridge Connection 
Use this type of connection to perform nonintrusive testing on a T1
circuit without being limited to a designated monitoring port with
the appropriate isolation.

Use this configuration to detect errors online, such as bipolar
violations and CRC errors, or to perform bit error-rate testing if a
known test pattern is being received.

For example, to connect the NetTek YBT1 to a T1 circuit without
loading the circuit, do the following:

1. Connect the RJ48-to-Alligator Clip Cable to the T1 Line Interface.
See page 1–5. 

2. Select the Bridge option button in the NetTek YBT1 Configura-
tion field.

3. Connect the “Receive” alligator clips to the appropriate points in
the service access. See Figure 3–3.

4. Select the Summary button on the NetTek YBT1.

5. Press Restart to clear any error/alarm counts and restart the test.
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66 Block
RJ48- Alligator

clip cable

Spade lug

Figure 3–3: Typical connections for bridge monitoring

Making a Terminate Connection
Use this type of connection to place the NetTek YBT1 at the end of a
service line when the line is out of service. With this configuration
you can test base station equipment independent of the service line
or the service line independent of the base station.

For example, to test CSU equipment off line, connect the NetTek
YBT1 as follows:

1. Connect the RJ48-to-Bantam Y to the T1 Line Interface. See
page 1–5.
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2. Select the Terminate option button in the NetTek YBT1
Configuration field.

3. Connect the “Transmit” Bantam plug to the IN side of the service
access as shown in Figure 3–4.

4. Connect the “Receive” Bantam plug to the OUT side of the
service access as shown in Figure 3–4.

5. Loop the DSX2 service panel at the NIU.

6. Select the Summary button on the NetTek YBT1.

7. Press Restart to clear any error/alarm counts and restart the test.

MON

OUT

IN

DSXX

IN

OUT

MON

From CSU

To CSU

Figure 3–4: Typical connections for terminating a T1 circuit
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Making a Loopback Connection 
Use this type of connection to retransmit the incoming signal back to
the point of origin through the NetTek YBT1. Looping back is
virtually equivalent to hard wiring the receive side of the line to the
transmit side of the line while allowing the NetTek YBT1 to make
measurements on the received data.

For example, to loopback a T1 circuit through the NetTek YBT1, do
the following:

1. Connect the RJ48-to-Bantam Y or RJ48-to-Alligator Clip Cable to
the T1 Line Interface. See page 1–5.

2. Select the Loopback option button in the NetTek YBT1
Configuration field.

3. Connect the “Transmit” Bantam plug or alligator clips to the IN
or OUT side of the service access, depending on the circuit you
want to terminate. Connect the “Receive” Bantam plug or
alligator clips to the other side of the line for monitoring
purposes. See Figure 3–5.

4. Select the Summary button on the NetTek YBT1.

5. Press the Restart button to clear any previous error/alarm counts
and restart the test.

MON

OUT

IN

DSXX

IN

OUT

MON

From CSU

To CSU

Figure 3–5: Typical connections for loopback mode
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Testing a Circuit 

After you connect to a signal, measurement results accumulate as
long as the NetTek YBT1 detects T1 pulses. You can view the test
results at the end of a timed test or while a test is running.

Typically, the first results you see in the main window are the
Summary Results, which consist of either an indication that the data
stream contains no errors, or that errors or alarms were detected
since the last restart.

If the NetTek YBT1 detects errors or alarms, open an Alarms or
Errors window to obtain additional information. These windows
provide graphical presentations of the most recent test events, as
well as indicators that show the current and past performance of the
T1 line under test. You can also view an itemized list of all the alarm
or error occurrences since the last restart.

You can view all of the DS0 time slots simultaneously on the Drop
DSO activity graph. A colored bar is displayed for each consecutive
time interval within the measurement time span. The display is color
coded to reveal common data problem patterns:

� Normally quiet channels may be disrupted by random noise.

� Channels normally containing variable data may be locked into a
continuous pattern.

� Normal startup protocol, represented by identifiable fixed bars,
may not change to a variable pattern.
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Selecting Settings 
The NetTek YBT1 automatically detects most of the parameters
necessary to test a T1 circuit. However, you can override any or all
of the automated settings to speed up synchronization or perform
specialized tests.

To set the NetTek YBT1 receive function for automated testing, do
the following:

1. Select Setup > Edit in the toolbar at the top of the startup
window.

2. Open the Instrument tab and configure the option buttons as
follows:

a. Line Coding: Same as Rx Signal.

b. Framing: Same as Rx Signal.

c. Transmit Clock: Recovered.

d. Generated BER Pattern: Same as Rx Signal.

The NetTek YBT1 will automatically detect data formatting and
analyze the received signal. To view summarized test results, press
the Summary button and check the T1 Circuit Test Summary line.
To view details on specific test results, press the Alarms or Errors
buttons.

Instrument Settings Window

The Instrument Settings window allows you to configure the NetTek
YBT1 for specialized testing of T1 circuits.

1. In the menu bar, select Setup > Edit to open the Settings
window. See Figure 3–6.

2. Select the option buttons appropriate to the tests you want to
make.
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Figure 3–6: Instrument settings window

Line Coding. Select the line coding for the YBT1 transmitter and
receiver.

� Same as Rx Signal. Automatically detects the incoming line
coding and configures the YBT1 receiver and transmitter to
match.

� AMI. The YBT1 receiver will not perform B8ZS decoding on
incoming data.

� B8ZS. The YBT1 receiver will not perform AMI decoding on
incoming data.

Framing. Select the frame formatting for the YBT1 transmitter and
receiver.

� Same as Rx Signal. Automatically detects the incoming framing
format and configures the YBT1 receiver and transmitter to
match.
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� D4. Configures the YBT1 to transmit and receive T1 data with
D4 (SuperFrame) framing.

� ESF. Configures the YBT1 to transmit and receive T1 data with
ESF (Extended SuperFrame) framing.

Transmit Clock. Select the YBT1 transmitter timing source.

� Internal. Configures the YBT1 transmitter to use the internal
crystal oscillator as a reference. See Appendix A: Specifications
for frequency information.

� Recovered. Configures the YBT1 transmitter to use the clock
recovered from the received data.

BER Pattern. Select the YBT1 transmitter and receiver Bit Error Rate
test pattern from the drop-down list box.

� Same as Rx. The YBT1 automatically detects the incoming
pattern and configures the receiver to match. Following
synchronization, the transmitter is configured to transmit the
same pattern.

� QRSS

� All Ones

� All Zeros

� 1 in 8

� 2 in 8

� 3 in 24

� T1-1 (Min/Max)

� T1-2 (Trip Test)

� T1-3 (54 Octet)

� T1-4 (120 Octet)

� T1-5 (53 Octet)

� T1-6 (55 Octet)

� User Defined. Create and edit your own BER pattern. All
patterns are defined in 8-bit octets.
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Transmit Level (dBdsx). Select the power level and pulse shape for the
YBT1 transmitter. You can adjust the settings to simulate the
insertion of varying lengths of twisted-pair cable. For example,
0 dBdsx corresponds to a “nominal” signal level of 3 V peak.

� 0.0

� –7.5

� –15.0

� –22.5

Pressing Apply to configure the YBT1 for the selected settings and
initiate a Restart. The Settings window will remain open.

Pressing OK to configure the YBT1 for the selected settings and
initiate a Restart. The Settings window will close and the measure-
ment window will return.

Pressing Cancel to return the original settings and cancel your
selections. The measurement window will return.
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Appendix A: Specifications 

This section lists the electrical, environmental, and physical
specifications of the NetTek YBT1 T1 Circuit Tester. All specifica-
tions are guaranteed unless labeled “typical.” Typical specifications
are provided for your convenience and are not guaranteed.

The electrical characteristics listed in Table A–1 apply to the T1
Circuit Tester operating within the environmental conditions listed in
Table A–2 on page A–2.

Table A–1: Electrical characteristics  

Characteristic Description

Transmitter Characteristics

Pulse Shape Compatible with ANSI TI.102, 1993 and
DS1, DSX-1 specifications, section 6.2.5 to
6.2.8 and 6.2.10.

Output Jitter UI peak-to-peak: � 0.02%
Compatible with PUB 62411.

Data Format, nominal AMI, B8ZS

Frequency accuracy, nominal �50 ppm

Receiver Characteristics

Sensitivity Terminate mode: 0 to –12 dBx1, 4

Bridge mode: 0 to –12 dBx2, 4

Monitor mode: –20 to –30 dBx3, 4

Input Impedance, nominal Bridge mode: � 1000 �
Monitor mode: 100 � �1.0%
Loopback mode: 100 � �1.0%
Terminated mode: 100 � �1.0%

Jitter Tolerance, nominal 400 to 100,000 Hz: complies with ITU, AT&T,
and Telcordia requirements for T1 applications
(PUB 62411, TRNWT 000499 Cat II, CCITT
G.823, ITU-TI.431).
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Table A–1: Electrical characteristics (Cont.)

Characteristic Description

Jitter Transfer Curve, nominal5 Attenuator meets the requirements of
PUB 62411, PUB 43802, TR-TSY 009,
TR-TSY 253, TR-TSY 499, and ITU-T1.431 and
G.703.

1 100 � input impedance. Employs long-haul equalizer.
2 1 k� input impedance. Employs long-haul equalizer.
3 100 � input impedance. Employs long-haul equalizer and 20 db amplification.
4 T1 Pulses Indicator (receive level) reports Weak Signal when lower amplitude

signals are detected.
5 NetTek Y350 reference clock.

Table A–2: Environmental characteristics  

Characteristic Description

Temperature Range

Operating 0 to +50� C (+32 to +122� F)

Nonoperating –40 to +60� C (–40 to +140� F)

Humidity

Operating 5 to 80% RH, noncondensing: 0 to +30� C
(14 to 86� F)

5 to 30% RH, noncondensing: +30 to +50� C
(86 to 122� F)

Nonoperating 5 to 80% RH, noncondensing: 0 to +30� C
(14 to 86� F)

5 to 30% RH, noncondensing: +30 to +50� C
(86 to 122� F)
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Table A–2: Environmental characteristics (Cont.)

Characteristic Description

Altitude

Operating 4,600 m (15,333 ft)

Nonoperating 12,192 m (50,000 ft)

Table A–3: Certifications and compliances  

Category Standards or description

EC Declaration of
Conformity – EMC

Meets intent of Directive 89/336/EEC for Electromagnetic
Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European
Union:

EN 61326 EMC requirements for Class A electrical
equipment for measurement, control, and
laboratory use.1,2,3

IEC 61000–4–2 Electrostatic discharge immunity
(Performance criterion C).

IEC 61000–4–3 RF electromagnetic field immunity
(Performance criterion A).

IEC 61000–4–4 Electrical fast transient / burst immunity
(Performance criterion B).

IEC 61000–4–5 Surge immunity
(Performance criterion C).

IEC 61000–4–6 Conducted RF immunity
(Performance criterion A).

IEC 61000–4–11 Voltage dips and interruptions immunity
(Performance criterion B).

EN 61000–3–24 AC power line harmonic emissions.
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Table A–3: Certifications and compliances (Cont.) 

Category Standards or description

Australia/New Zealand
Declaration of
Conformity – EMC

Complies with EMC provision of Radiocommunications Act 
per the following standard:

AS/NZS 2064.1/2 Industrial, Scientific, and Medical
Equipment:1992.

FCC Compliance Emissions comply with FCC Code of Federal Regulations 47,
Part 15, Subpart B, Class A Limits.

U.S. Nationally
Recognized Testing
Laboratory Listing

UL 60950 3rd edition Safety of Information Technology Equipment.

1 Emissions which exceed the levels required by this standard may occur when
this equipment is connected to a test object.

2 Compliance demonstrated using high-quality, shielded interface cables.
3 Compliance demonstrated with NetTek YBT1 PC card installed in the rear

PCMCIA slot of the Y350 NetTek Analyzer Platform.
4 (A14)

Table A–4: Physical characteristics 

Characteristic Description

Dimensions1 Height: 25 cm (9.75 in)
Width: 33 cm (13 in)
Depth: 9 cm (3.5 in)

Weight1 One battery installed: 4.23 kg (9.2 lbs)
Two batteries installed: 4.82 kg (10.2 lbs)

1 Y350 NetTek Analyzer Platform with NetTek YBT1 PC card installed.
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Appendix B: Accessories

This section lists the NetTek YBT1 T1 Circuit Tester standard and
optional accessories.

Standard Accessories
Table B–1 lists the accessories included with your tester.

Table B–1:  Standard accessories

Quantity Part number Description

1 ea 015-0694-00 YBT1 PC Card

1 ea 119-6618-00 T1 Line Interface

1 ea 020-2424-00 Component kit:
RJ48 loopback plug, single port
RJ48-to-Bantam Y cable

1 ea 070-9964-00 NetTek YBT1 T1 Circuit Tester User
manual. Includes software installation
CD-ROM. 
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Optional Accessories
Table B–2 lists the optional accessories you can purchase for your
YBT1 T1 Circuit Tester. Contact your Tektronix representative or
distributor for ordering information. See page ix for information on
contacting Tektronix.

Table B–2:  Optional accessories

Part number Description

020-2425-00 Component kit, contains 1 each:
 RJ48-to-RJ48 straight-wired cable, 6 ft

RJ48-to-RJ48 cross-wired cable, 6 ft
RJ48-to-Alligator clip cable, 6 ft
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Appendix C: Diagnostic Self Tests  

To verify the NetTek YBT1 T1 Circuit Tester is functioning properly,
run the diagnostic self tests. 

NOTE. The following verification procedure does not confirm that the
YBT1 T1 Circuit Tester meets or exceeds the specifications listed in
Appendix A–1.

1. Install the RJ48 Loopback Plug into the T1 Line Interface as
shown in Figure 1–5 on page 1–10.

2. Power on the NetTek Analyzer Platform. See page 1–9 for
instructions.

3. Select File > Exit in the YBT1 application if the T1 Circuit
Tester is running.

4. In the taskbar, select Start > Programs >Tektronix Utilities >
Diagnostics.

5. Tap the + box next to All Modules, All Tests to expand the
selection tree.

6. Tap the + box next to Platform.

7. Deselect all platform diagnostics (remove all checks).

8. Tap the + box next to Platform again to compress the menu tree.

9. Tap the + box next to YBT1.

10. Verify that General Tests and Line Port Tests are checked.
Deselect (uncheck) the Ref Port Tests. See Figure C–1.

NOTE. If your NetTek YBT1 does not include a reference port,
deselect (uncheck) the Ref Port Tests check box.
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Figure C–1: YBT1 diagnostic settings

11. Select the LOOP option button.

12. Set the loop count to 1 with the up/down arrow buttons.

13. Select Run to start the diagnostics.

14. Verify that each test executes and passes.

15. Select Close to exit the diagnostic system.

If you encounter errors, open the Failure Log tab to obtain more
information.
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Test Descriptions 
You must install the RJ48 Loopback Plug into the T1 Line Interface
to run any of the following tests individually.

General Tests

Verifies that the NetTek YBT1 software module loaded onto the
Y350 NetTek Analyzer Platform is communicating with the YBT1
PC card.

Line Port Tests

Verifies that the Line port is functioning properly in both the transmit
and receive modes (through the loopback plug).

A transmitted reference pattern is compared to the received data
pattern for an exact match. This test also verifies that the internal PC
card hardware is functioning properly.

NOTE. If your NetTek YBT1 does not include a reference port and you
did not deselect (uncheck) the Ref Port Tests check box in step 10 on
page C–1, the diagnostics will report this test as failed.
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Appendix D: Installing NetTek YBT1
Software 

You can use the following methods to install, reinstall, or upgrade
NetTek YBT1 software on the Y350 NetTek Analyzer Platform.

� Serial Connection Method. Uses a standard serial (RS-232)
connection between a host PC and the NetTek Analyzer Platform.

� Archive File Method. Uses a PC memory card installed in the
Y350 NetTek Analyzer Platform.

PC Requirements
This installation requires a desktop PC with CD-ROM drive and
Windows 95, 98, or NT 4.0 operating system.

Installing From a Serial Connection
This upgrade procedure requires a serial connection between the
NetTek Analyzer Platform and the desktop PC.

1. Connect one end of the standard accessory Y350 NetTek
Analyzer Platform RS-232 cable to the serial (COM) port on the
desktop PC. See your computer documentation for the port
location.

2. Connect the other end of the cable to the Y350 NetTek Analyzer
Platform serial port. See the NetTek Analyzer Platform user
manual for the port location.

If the desktop PC serial interface has already been configured to use
Windows CE Services or Active Sync, you must disable the serial
connection.
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Disabling the Windows CE Services Serial Connection 

If Windows CE Services is installed, do the following to disable the
serial connection:

1. Right-click on the CE Services icon in the desktop PC status area;
then select Communications.

2. In the Windows CE Services Properties dialog box, open the
Communications tab.

3. In the Device Connections via Serial Port field, deselect Enabled.
(Enable mobile device connection must already be selected to
make this selection).

4. Select OK; then close the dialog box.

Disabling the Windows Active Sync Serial Connection 

If Windows Active Sync is installed, do the following to disable the
serial connection:

1. Right-click on the Active Sync icon in the desktop PC status area;
then select Connection Settings.

2. In the Connection Settings dialog box, deselect the Allow serial
cable or infrared connection to this COM port check box.

3. Select OK to close the dialog box.

Installing the YBT1 Software

To install the NetTek YBT1 software on the Y350 NetTek Analyzer
Platform, do the following:

1. Insert the NetTek YBT1 software installation CD-ROM into the
desktop PC.

2. The disk should start up automatically. If it does not, run
setup.exe in the CD-ROM root directory.

3. Follow the on-screen instructions provided by the upgrade
wizard.

4. When the module upgrade is complete, shut down the NetTek
Analyzer Platform and install the NetTek YBT1 PC card.

5. Start up the NetTek Analyzer Platform.
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The NetTek YBT1 T1 Circuit Tester is now ready to use. To start the
application, double-click the YBT1 icon on the NetTek Analyzer
Platform desktop or select Start > Programs > NetTek > YBT1.

NOTE. When you have completed the upgrade process, be sure to
re-enable your Windows CE Services or Active Sync serial
connection.

Installing Using an Archive File 
To install the NetTek YBT1 software using an archive file, do the
following:

1. Use a desktop PC to copy the archive file ybt1.arq in the
Upgrade > Archive directory of the NetTek YBT1 software
installation CD-ROM to a PC memory card.

2. On the NetTek Analyzer Platform, select Start > Shutdown; then
select Shutdown.

3. Remove the NetTek YBT1 PC card if installed.

4. Insert the PC memory card containing the ybt1.arq file into the
NetTek Analyzer Platform.

5. Start up the NetTek Analyzer Platform.

6. On the NetTek Analyzer Platform, select Start > Programs >
Tektronix Utilities > Module Upgrade. Follow the on-screen
instructions to install the NetTek YBT1 software.

7. When the YBT1 module upgrade is complete, shut down the
NetTek Analyzer Platform and remove the PC memory card.

8. Insert the NetTek YBT1 PC card into NetTek Analyzer Platform.

9. Start up the NetTek Analyzer Platform.

The NetTek YBT1 T1 Circuit Tester is now ready to use. To start the
application, double-click the YBT1 icon on the NetTek Analyzer
Platform desktop or select Start > Programs > NetTek > YBT1.
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Index

A
Accessories, 1–3

optional, B–2
standard, B–1

Address, Tektronix, viii
Alarm/Error Count window, 2–12,

2–19
Alarms

display, 2–16
set timespan, 2–16

window, 2–11, 2–15
Assemble, product, 1–5
Automatic testing, 2–11, 3–8

B
Base station, connecting to, 3–1
Battery

indicator, 2–3
recycling, v

Button
alarm/error count window, 2–12
alarms history, 2–16
alarms window, 2–11
automatic testing, 2–11
desktop, 2–4
drop DS0, 2–10
errors history, 2–17
errors window, 2–11
help, 2–7
input/output configuration, 2–10
program, 2–5
restart, 2–11, 2–14
show last result, 2–11
summary window, 2–11
timed test, 2–11

C
Cable

line interface adapter, 1–4
restraint, 1–8
test

RJ48 loopback, 1–4
RJ48-to-Alligator clip, 1–4
RJ48-to-Bantam cross-wired,

1–4
RJ48-to-Bantam straight-wired,

1–4
RJ48-to-Bantam Y, 1–4

Cable kit, optional accessory, B–2
Card, PC, 1–4
CD-ROM, 1–4
Certifications

EC, A–3
EMC, A–3
FCC, A–3

Channel service unit, 3–1
Components, NetTek YBT1, 1–3
Configuration buttons, input/out-

put, 2–10
Connecting the tester, 3–1
Connection

alligator clip to 66 block, 3–3
bridge, 3–3
loopback, 3–6
monitor, 3–1
terminate, 3–4
to end of service line, 3–4

Connector, loopback, 1–4
Contacting Tektronix, ix
Controls, 2–2

shared, 2–8



Index

Index–2 NetTek YBT1 T1 Circuit Tester User Manual

D
Data, retransmit, 3–6
Desktop

icon, 2–4, 2–5
overview, 2–3
program button, 2–5
Start menu, 2–4
status area, 2–5
taskbar, 2–4

Diagnostic tests, C–1
test descriptions, C–3

Dimensions, external, A–4
Disable

Windows Active Sync, D–2
Windows CE Services, D–2

Display
alarms, 2–16
errors, 2–18
touch-screen, 2–1

Dongle, 1–4
Drop DS0, button, 2–10
DS0, view activity, 3–7
DSX panel, 3–1

connecting to, 3–1

E
Electrical specifications, A–1
Emissions, electromagnetic com-

pliance, 1–6
Environmental specifications, A–2,

A–3
Error

display, 2–18
set timespan, 2–18

insertion, 2–18
Errors window, 2–11, 2–17

F
Failure log, C–2
Features, product, 1–2
File menu, 2–9
Find information, start Help, 2–7
Frame synchronization indicator,

2–12
Front-panel controls and indicators,

2–2

H
Hardware reset switch, 2–2
Help

icons, 2–7
information, 2–7
window, 2–9

Hide program, 2–5
History, alarms/errors count, 2–19
History button

alarms, 2–16
errors, 2–17

I
Icon

?, 2–7
desktop, 2–4, 2–5
status, 2–5
toolbar, 2–9
YBT1 start up, 1–9

Indicator
display, 2–3
frame synchronization, 2–12
line coding, 2–13
pattern synchronization, 2–12
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power on, 2–3
T1 pulses, 2–12
weak signal, 2–12

Information, getting help, 2–7
Injury, from lightning, 1–12
Input connection, 3–1
Input panel, enter keyboard charac-

ters, 2–6
Install

PC card, 1–6
software, 1–5, D–1

from archive file, D–3
from serial cable, D–1

Instructions, operating, 2–1
Instrument settings, 3–8

K
Keyboard, (soft) input panel, 2–6

L
Lightning, avoiding personal injury,

1–12
Line coding indicator, 2–13
Line interface adapter, PCMCIA,

1–4
Lock-up, 2–2
Log, failure, C–2
Loopback, 3–6

plug, 1–4, C–3
for performance check, 1–10
install, 1–10

Low battery indicator, 2–3

M
Manual, user, 1–4, B–1

Menu
help, 2–7
Start, 2–4
toolbar, 2–9

Monitor, data path
customer side, 3–1
high-impedance connection, 3–3
network side, 3–1

N
Network interface unit, 3–1

O
Operating, instructions, 2–1

P
Pattern synchronization indicator,

2–12
Pause, button, 2–9
PC card, 1–4

emissions compliance, 1–6
install, 1–6
product assembly, 1–5

Performance verification, 1–10,
C–1

test descriptions, C–3
Phone number, Tektronix, ix
Power

off, 1–10
on, 1–9
switch, 2–2

multiple functions, 1–11
Product

assembly, 1–5
features, 1–2
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support, contact information, ix
Program button, 2–5

R
Recycle, battery, v
Reset

hardware, 2–2
software, 1–11

Restart
a test, 2–11
button, 2–14

Restrain cables, 1–8
Retransmit data, 3–6
Rolling display

alarms, 2–16
errors, 2–18

S
Safety

lightning, iii
summary, iii

Select, on-screen items, 2–1
Serial cable, for software upgrade,

D–1
Service, support, contact informa-

tion, viii
Settings, change, 3–8
Setup menu, 2–9
Shared controls, 2–8
Show last result, 2–11
Shut down power, 1–10
Software

install, 1–5, D–1
CD-ROM, 1–4

install from, serial cable, D–1
reset, 1–11
upgrade, 1–5

version, viii
Specifications, A–1

altitude, A–3
electrical, A–1
environmental, A–2, A–3
humidity, A–2
temperature, A–2

Standby mode, 1–10
Start, menu, 2–4
Start up

power, 2–2
YBT1, 1–9

Status
area, desktop, 2–5
icons, 2–5

Stylus, 2–1
Summary window, 2–11, 2–14, 3–7
Suspend

analyzer activity, 1–10
front-panel, switch, 2–2

Switch, power, 1–11

T
T1 pulse indicator, 2–12
T1 testing

connecting to a circuit, 3–1
overview, 3–7

Taskbar, desktop, 2–4
Technical support, contact informa-

tion, ix
Tektronix, contacting, ix
Test

diagnostic, C–1
nonintrusive, 3–3
strategy, 3–7, 3–8
summary, 2–14
T1 data path, 3–1

Timed test, 2–11
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Toolbar
buttons, 2–9
icons, 2–9
menus, 2–9

Tools menu, 2–9
Touch screen, 2–1

U
Upgrade, software, 1–5, D–1
URL, Tektronix, viii

V
Verify performance, 1–10, C–1

Version, software/hardware, viii
View DS0 activity, 3–7

W
Weak signal indicator, 2–12
Web site address, Tektronix, ix
Weight, A–4
Window

alarm/error count, 2–19
alarms, 2–15
errors, 2–17
start up, 2–14
summary, 2–14
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